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What is Codebook

Encrypted Data Vault

Guards passwords and private data
Keeps sensitive information organized
Enables quick recall of secrets

Syncs data across multiple devices

iOS (iPhone / iPad)
Android

Windows
Mac OS X

Codebook
File  Edit Sync

BEEB

View  Help

B 8 8 /7
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n Dropbox
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£ icloud
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Security

256-bit AES encryption

Peer-reviewed storage engine
Data Protection:

Encrypted at rest on device
Encrypted in transit during
sync

Encrypted at rest on all
cloud services

Data encrypted with your
Sync Key and Master

Password
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Getting Started



Master Password

Setup your Master Password on first
use

It's required each time you access
your Codebook data.

Your Master Password is used to
encrypt your data on your device. ltis
not stored in Codebook.

Recommendations:

- at least 8 characters including 1 of
each, capital, number, lowercase, and
special character, ex: ! § ?

- Complex and difficult to guess

*** You must remember your Master
Password. It cannot be recreated
outside of Codebook ***

Previous
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Set Your Master Password

Choose a strong Master Password, one that you will remember.
Codebook will use this to generate a key for encrypting your data.

eeesescssesceses - |

Next




Welcome

Menu
Toolbar
Search
Category List
Entry List
Entry View

File

*

o
O

7

D

By & N

Edit  Sync

EEb |

Favorites

Recents

History

Categories

Airlines

Cloud Services

Credit Cards

Delivery

View  Help

7

i %

& Double Drive

Q Dropbox

{—

3 icloud

i H Spider

Google Drive

Oak

5 gntries

® ©

T O

| O v o Q e
Google Drive
Cloud Services
[ — ]

‘= Fields 2 Images

Username mmalibu@zetetic.net
ToTP 554245 @
Password ceccssecccccccee

Website accounts.google.com

Z#’|Edit  Updated At: Friday, March 9, 2018 11:18:00 AM
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Data model

Category

e  Groups records
e Navigation-based retrieval

Entry

e Record with multiple fields; or
e A multi-line note

File  Edit  Sync

I <
W Favorites
© Recents
Q) History

Categories
/ Airlines
q Cloud Services

[—
[~ ] Credit Cards

% Delivery

LY

Category

View  Help

B8 & 8 /7

| ® © @ O

i %
% Double Drive
Q Dropbox

Google Drive

3 icloud

% Spider Oak

. a 5 entries

& v Ly

Google Drive
Cloud Services

[/ (*)
= Fields B Images
Username mmalibu@zetetic.net
TOTP 554245

Password eeesccsssscscces

Website accounts.google.com

# Edit  Updated At: Friday, March 9, 2018 11:18:00 AM

Entry
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Field

Data model

File Edit Sync View Help

: > = I W) vee Q
Fields EEB | B BRBE /20 x| ®0 00| ¢V ”
* Favorites H Double Drive g:::;::::e w
[/ ()]
e  Store related data on an entry © Recens [ e
e e.g.username, password = s
'@ History .. Google Drive
ername mmalibu@zetetic.net
Labels Categories B icoud ToTP 554245
H i | 5 Spider Oak Phssword|sssssserssssssass
([ ] Deflne the Fleld type E3 cloud Services .
—— Website accounts.google.com

e [Establish behavior (e.g. launch
email, generate password)

-_ Credit Cards

&b Delivery

F=

B B sentries 2 Edit  Updated At: Friday, March 9, 2018 11:18:00 AM

Label
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Create a Category

New Category or (ctrl+shift+n)
Enter Descriptive Name
Choose Icon

Save

[ <
Y Favorites
© Recents
Q) History

Categories
/ Airlines
g Cloud Services

g Codebook Cloud

.— Credit Cards
&1 Nalivan:

A Ne‘N Category{ X

B

Save

] B Oentries

N




Create an Entry

New Entry or (ctrl+n)
Enter Descriptive Name
Choose Icon
Add Fields
a. Choose Label
b. Enter field value
Click the “Favorite Star” to mark
the most important entries
Save entry

File Edit Sync View Help

* Favorites

{9 History

Categories

A New Category

g Cloud Services

[ &
=] Credit Cards

EEmEB B85/

A New Entry
A New Category

@ Images

€Acancel

Generate i




Special Labels & Behaviors

e Password/PIN

o Masked

o  Supports random generation
e Note

o Free text entry
e \Vebsite

o Launches browser on double click
e Email

o Launches email client on double click

e 2-Step Code

o Generates time-based one time passwords (e.g. for Google 2-step)



Create a Note

File Edit Sync View Help
Add Note Entry EEmEB | B8 E /i x| © O | & v -

First line becomes title W Favorites This is a new rote. SR es

. e It is a free form, text field. When your note is saved the data is
M u |t| | N e teXt Content ® REcoRis encrypted so it is secure. Note entries can be searched. You just type
Save note

1
Welcomme to'6dlebook! the search criteria in the

{9 History
Categories

Meeting Notes

~ Messaging

Notes

. Passwords

B B entries Rsave  €Cancel VY Updated At

s/ 4
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Deleting records

File  Edit Sync/ View Help

: . I N Q
Delete category (and all entries) AL A L e on eV .
Delete entry (and all fields) K Fovoites M Doube drive _ | Lpouble Drive %
. 0 9] Cloud Services
Delete f|e|d ® Recents Q Dropbox S—
a - Edit = Fields 2 Iimages
b Cl k . '@ History .. Google Drive
- ICK MInus Username mmalibu78
Categories q icloiid
| ANew Category | m I ofmq jnnw nfso h3z5 bpfh b7jz 6e
¢ 5% Spider Oak g
l Aittiries ;-=sDNyw"=Iri(N Generate
Be careful not to lose information, O coud servce ®
these operations cannot be undone.
i- Credit Cards
B B 5entries Psave  €3Cancel Updated At: Thursday, April 12, 2018 11:51:02 AM

AN
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Navigation and Retrieval



Categories

Navigate through your own custom
organization structure

Choose a Category from the
navigation area
2. Choose an Entry

Categories and Entries are sorted
alphabetically

i B
* Favorites

® Recents
'@ History

Categories
ﬂ Documents
-1:% Family

‘ Financial
n Gaming

~a

File Edit Sync View| Help

| B/8 8 @ x | ®0 B O [ o v B
Bl mmmmm Diner's Club
22 401k b pia o
w inancial
Banque Cantonale...

= Fields  [A Images

Checking Account
Account 4676645424231123

Debit
< Expiration 03/22/2017

Diner's Club CVV/CVC «e-

eWallet Credit Limit $15,000

Financial Advisor... Payment Due 10th of the month every 3 months

- Google Wallet

B B 11entries 2 Edit  Updated At: Thursday, November 19, 2015 6:22:38 PM

2
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Favorites

Entries marked with the Favorite star
are quickly accessible

Tap “Favorites” from the
navigation area
2. Choose Entry

File  Edit  Sync

E B
* Favorites
@ Recents
{9 History

Categories

ﬁ Documents

=)
‘ Car2Go
=

@Codebook

Twitter

/ American Airlines
4

Airlines

Amex
Credit Cards

Rental Services
&) CitiBike
Rental Services

Debit

—
- Financial

™ Dr. Nick Riviera
o Medical

i E 29 entries

© @ @ [ & 7 oo Q.

s Debit

Financial

= Fields 2 Images
Account 6428922589722593
Expiration 11/12/2023
CVV/CVC -

PIN «eee

# Edit  Updated At: Wednesday, August 14, 2019 12:00:47 PM
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Recents

Quick retrieval of the 20 Entries most
recently accessed

Choose “Recents” from the
navigation area
2. Choose an Entry

The most recently viewed entries are
automatically displayed at the top of
the list

[ X
* Favorites

@ Recents
'@ History

Categories

ﬂ Documents
o, Family

‘ Financial
a Gaming

File  Edit  Sync

Vie Help

B 5 /2 8 % |

Debit

Financial

@Codebook
Twitter

O §

Diner's Club
Financial

Double Drive
Cloud Services

M} B
13 I

This is a new note.
Notes

A New Entry
A New Category

a

Google Drive
¥ Cloud Services

ﬁ a 8 entries

® om0 | & v - Q.

= Debit

ﬁ Financial

= Fields [ Images
Account 6428922589722593
Expiration 11/12/2023
CVV/CVC ---

PIN «eee

# Edit  Updated At: Wednesday, August 14, 2019 12:00:47 PM
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Search

Quick retrieval of information based on
keyword

1.  Enter search criteria
2. Choose Entry

Entry names and all field values are
included in search

File  Edit  Sync

kB
* Favorites
@ Recents
'@ History

Categories

ﬁ Documents

ﬁ Family

‘ Financial
ﬂ Gaming

View  Help

8B B B /

i * ‘ ® © [m] ] | & v O\V card X

s United Airlines Card

=== United Airlines Card i

B siines Airlines

== Mastercard .

B it cords = Fields  [A Images

Perscription Card Account 3459222696257262
Medical

“»
v

Expiration 07/16/2016
CVV/CVC ---
Credit Limit $7,000
Miles Per Dollar 2

Payment Due 20th of each month

B B 3entries 2 Edit  Updated At: Thursday, September 14, 2017 9:48:58 AM
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Copy / Paste

Data can be copied to the clipboard

1. Select Field
2. Right click or ctrl+c

Paste into other applications

Clipboard is managed and cleared
automatically

File  Edit Sync View Help

m D
* Favorites
® Recents
'(9 History

Categories

| B B B 728 *x | ® 000 | & v - Q, crd

=== United Airlines Card
“ Airlines
=== Mastercard
- Credit Cards
1, Perscription Card
Y Medical
i a 3 entries

s United Airlines Card

Airlines

= Fields [ Images

Account 3459222696274

1 / Expiration 07/16/2016

CVV/CVC ---
Credit Limit $7,000

Miles Per Dollar 2

2 - right
click

Copy Ctrl+C
Hide Account

Magnify Account  Ctrl+Y

Payment Due 20th of each month

2/ Edit  Updated At: Thursday, September 14, 2017 9:48:58 AM
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Secret Agent



Secret Agent

Global keyboard shortcut to launch
Codebook search from any app

Insert data into an active text field (e.g.

a website password in your browser)
Available on Desktop Only

Secret Agent is automatically enabled
on Windows

o G Sign in - Google Account: X

& C [ https://accounts.google.com/ServiceLogin?hl=en8&passive=truecontinue=https://wwyy =

'y
"* Acceler

popup with tags read later my pinboard &1 White Noise

CGanale

» (] Other bookmarks

good

44

A )

Google Drive

« Cloud Services

8 oo Google+
Social

Need help?

Create account

One Google Account for everything Google




Lo G Sign in - Google Account: X

L (& https://accounts.google.com/ServiceLogin?hl=en&passive=true&continue=https://wwiy =
p goog 9 P! p
28 Acceler popup popup with tags read later my pinboard &1 White Noise » (] Other bookmarks

Press CTRL-SHIFT-\ Google

Enter search term One account. All of Google.
Arrow down or up to navigate

Press return to select Entry
Arrow down or up to select Field

Sign in with your Google Account

> Google Drive

ee Cloud Services

PreSS return to enter Value to Username mmalibu@zetetic.net
active Text area with cursor Tore 637385 @
PassSWOrd seeesscsscccsces -
Tip: Favorite entries will sort to the top
S gt T
v/ Stay signed in Forgot password?

Sign in with a different account




Synchronization



Synchronization

Codebook can keep data in sync
across multiple devices.

Changes made on any device can be
merged.

All devices to be synced share the
same Sync Key. Your Sync Key is

generated once and used for all of
your devices.

Types of Syncing:
1. Codebook Cloud **
2. Cloud Service (Dropbox or
Google Drive
3. Desktop WiFi

** Codebook Cloud is a subscription
service that automatically syncs your
devices as changes are made.

One Sync Key is used for all
devices being synced

New data and
changes are merged
across Codebook

apps

Desktop

Sync Using
Codebook
Sync Key

Mobile



Codebook Cloud
Synchronization

Codebook Cloud is a subscription sync
service that allows you to make
changes to your Codebook records on
multiple device and it will automatically
keep them up-to-date

All of your devices must have
Codebook Cloud selected as the sync
preference and be signed in to the
same Codebook Cloud account.

** The same Sync Key is used for all of
your devices **

Desktop

/

Sync is triggered on

each device on
automatically

Codebook
Cloud

Mobile

Changes are stored in
a central copy



Create Codebook
Cloud Account

Codebook Cloud is an optional subscription
service that automatically syncs your changes to
all of your devices.

You can create a Codebook Cloud account during
Codebook installation or from the Sync
Preferences Menu.

During Installation:

1 - Enter your email
2 - Click continue then follow instructions
OR
After Installation from Sync Preferences:
1 - Codebook Preferences (File -> Preferences)
2a - Sync tab
2b - Sync Service - Codebook Cloud
2c¢ - Click Sign In then follow instructions

For More Info:
https://www.zetetic.net/codebook/documentation/create-codeb
ook-cloud-account/?platform=macos

During
Installation:
1 \ Codebook Cloud account:
\H
:gg: Scan Sync Key...
From Sync
Preferences
Preferences:
/ Enable sync with:
2a
2 b / Sign In
/
2C / Privacy Policy

6 Codebook

Welcome to Codebook

New To Codebook? Codebook Cloud includes:
« All Codebook core features

Enter your email address to create a i
« Auto synchronization on all platforms

« Unlimited secure storage
« Learn more

Already Using Codebook?

« Quick sign in with QR code
« Username & password accepted too /

Continue

8 General Q Sync EQ Secret Agent @ Updates

and allowing access to your
/ Codebook Cloud content on other devices.

Sync can be used to create a
backup of your Codebook data,

Learn More

Save Cancel




Initial Sync Key Setup

If you created a Codebook Cloud
account during installation, your Sync
Key was generated for you.

If you need to create a Sync Key,
select Setup Sync Key from the Sync
Menu

Since this is your initial Codebook
setup

Click No, Next to generate your Sync
Key

Your new Sync Key will be generated

** A new Sync Key is generated
only once and needs to be
imported to ALL other devices. **

Setup Your Sync Key

Codebook uses a Sync Key to encrypt all your data during sync
with a cloud service or another computer. Your Sync Key is

separate from your Master Password.

®

Have you already created your Sync Key in another copy of

Codebook?

O Yes

No
/ o

S

Sync Key Imported

9

Your imported Sync Key is ready!

To enable sync with other copies of Codebook, you can access
your Sync Key from the Sync — Add a New Device menu.

Previous Next
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Backup Sync Key
Your Sync Key is used to encrypt your Codebook sync data. It is very important to
. backup your Sync Key, if it is lost it cannot be recovered. We highly recommend
Your Sync Key IS needed to encrypt and decrypt Z:izii;gr:ntaiZuapfﬁ:de, writing down a Backup Word List for secure offline storage,
your data when syncing your devices. You should Chiogse albaclap optior:
generate a backup of your Sync Key so you can |~ ek
. . . . Write down Backup Word List
retrieve your data in the event that your device is lost 1 — - 3
(O save Sync Key to file =
or damaged. O Not now
. q 2 - Next
Options for creating a Backup Sync Key:

1. Print a Backup Code
- a QR code representing your Sync Key e
encrypted with your Master Password ty Sync Key Word List

** Be sure to write down your Master Password of the Codebook sacku code EE:}}?:J':;fzs"ecnf:ﬁyl::o;?yz:trE's;::tkoet Makig el copy .
device generating the backup in the space provided ** 10O NOT PHOTOGRAPH
2. Write Down Word List 1. scaling scalping  unwiitlen  menkind  puncus

- a list of 20 words that can be used to generate L we B
the same encryption key that is stored in your Sync 4 washday  dude biip shaping _justness
Key.
Master Password not required to decrypt a Word List / prvius oone

3. Save As File

- creates a file that can be copied to another

** write your Master Password** =

device for backup or import
## Master Password required to decrypt the file - be sure

Select location
to save file

to keep a record of it ##
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|mp0rt an Existing __

Sync Key Codebook 2 scnQRcode
To display your Sync Key QR code on another device: select Add
- I I I t - a New Device from the Sync menu on desktop, or from the Sync
« Auto synchronization on all platforms

screen on mobile.
During initial setup, you will be given the
option to Scan your Sync Key 1 I e s

Welcome to Codebook

New To Codebook? Codebook Cloud includes:

Enter your email address to create a *.All codebookicorefeatiires

Codebook Cloud account:

N Already Using Codebook?
Process

I — « Quick sign in with QR code
S e « Username & password accepted too

1 - Click Scan Sync Key
2 - Scan Sync Key QR Code(s)
3 - Enter Master Password for Sync Key Setup Later e

% - Click Process |

5 - Confirmation of Successful Import
Scan QR Code

To display your Sync Key QR code on another device: select Add 5 Sync Key Imported

TO ImpOI't your SynC Key after |nsta”at|0n, a New Device from the Sync menu on desktop, or from the Sync
screen on mobile.
select Setup Sync Key from the Sync 3\ @

g’

menu (L]
Scan Complete Your imported Sync Key is ready!

To enable sync with other copies of Codebook, you can access

your Sync Key from the Sync — Add a New Device menu.

nter the master password associated with this QR code

Previous

Process

. 4

4~ 6 Codebook

Previous




Import an Already
Existing Sync Key

1. From the Sync Menu, tap Setup Sync Key

2. Since you already have a Sync Key, click Yes
and you will be prompted to scan your Sync
Key.

To import your existing Sync Key you can scan it
from another device or from a printed copy.
To Display Sync Key from the desktop app:-

select Sync menu > Add a Device From the To
Display Sync Key from mobile device: -

Sync View > Add a Device

This will display a QR code containing an encrypted
representation of your Sync Key.

3. Click Scan Sync Key and scan the displayed
QR code to store it in the new device. You then
need to enter the Master Password used when
the sync key was generated.

** There is only one sync key that
is used for ALL of your devices.

*%*

Setup Your Sync Key

Codebook uses a Sync Key to encrypt all your data during sync
with a cloud service or another computer. Your Sync Key is
separate from your Master Password.

®

Have you already created your Sync Key in another copy of
Codebook?

/@ Yes
O No

Previous

Import Sync Key

An existing Sync Key may be imported using these options:

o Scan QR code
/(: Enter word list

() sync Key file

Next




e
Import an Already Scan QR Code

To display your Sync Key QR code on another device: select Add

] .
a New Device from the Sync menu on desktop, or from the Sync
XI S I n g y n C e y screen on mobile.

(continued)
[
Scan Sync Key:

4. Scan the QR code using your prvious
computer’s camera
5. Enter the Master Password that was e
used when the Sync Key was created

: Scan QR Code
6. Click Process

To display your Sync Key QR code on another device: select Add
a New Device from the Sync menu on desktop, or from the Sync
screen on mobile.

g’
l_i:",:j.'_, Sync Key Imported

Scan Complete @
Enter the master password associated with this QR code
I Your imported Sync Key is ready!

To enable sync with other copies of Codebook, you can access
your Sync Key from the Sync — Add a New Device menu

Previous Process

P

Previous Next

6
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: word
Enter WOrd LISt to L|St Enter Your Word List

To restore your Sync Key, enter your word list below:

I m po rt Syn C Key 1. |fable | |kebab | |Iaboring l |paciﬁc l |dab I
Sync Key Imported

2 |cabbage | |jai|break | |ultra | |each | |karate |
3 |zero | |safari | |qualm | |kept | |magma | @
E t H | I I | | oo | Your imported Sync Key is ready!

e Wo d L St to 4. |halt cadd: nastil; ic oa d

n r r I = = = To enable sync with other copies of Codebook, you can access

Import Sync Key

your Sync Key from the Sync — Add a New Device menu.
- Enter the 20 words in the Word List in et
order
- Click Next

Import File:

« v 4 H> ThisPC > Desktop v o Search Desktop
Organize > Newfolder = m @
H Import Sync Key File P A Name T
Select your Sync Key file below and enter the Master Password used when the file was
created.

1 - Select the location of the file *
2 - Click Open

3 - Enter your Master Password
4 - Click Import 3

z File name: | Codebooksync <] | Codebook ynckey (synckey)
e 4 TS synckey ync Key (synckey)

1 ———P  Select Sync Key File...

port

e

2
6 Codebook

* the file was created with the name
Codebook.synckey




Set Sync Preference

1. Select Flle - > Preferences -> Sync Tab

2. Select your Sync Service from the list.

SYNC NOTES:
You need a Codebook Cloud subscription to
automatically sync your devices

Authenticate with the service once and allow
Codebook to link to your personal cloud
account

Desktop WiFi sync is initiated from the iOS or
Android device

NOTE: even if you only use Codebook on one device,
Syncing your data creates an encrypted backup copy of
your data in a cloud service which will allow you to
restore your data in case your device is lost, damaged or
stolen.

** You will need a Backup Sync Key to restore your data.

2 General Q Sync

Preferences

Enable sync with:

E& Secret Agent @ Updates

Sync can be used to create a
backup of your Codebook data,

‘ Dropbox
Codebook Cloud
Dropbox
Google Drive
Desktop WiFi
Local folder

None

and allowing access to your
content on other devices.

Learn More

ahoo.com

Save Cancel
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How to sync with a 1
Cloud Service

= (]
File Edit Sync View Help
EEEB | B R B /208 x | ®@ 0008 | & v - Rz
Start Sync — ———p
: . * Favorites —,/i 401k M Financial
Authenticate to Cloud Service -
. @ Recents ™
Trigger sync on any other 1
deViceS tO transfer data @ o - 5% - Initializing synchronization lername mmalibu78
Categories -_ T
Tip: Sync periodically to keep an ] . & -
up-to-date encrypted copy of your data = -
in case of machine failure & —
~ *
B B 11entries /' Edit  Updated At: We‘d‘r;esd'a’y, Aug‘u.st14, 2019 11:35:23 AM
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Cloud Service Sync example

Computer Mobile

1. Add a new entry in Codebook Desktop
2. Start Sync
3. Changes copied to Google Drive or Dropbox
\ Start Sync
Desktop changes merged from
Drive to Codebook Mobile
Edit Entries on Codebook Mobile

Start Sync

6.
7.
8. Mobile changes copied to Google Drive or
/ Dropbox
9. Start Sync

10. Mobile changes merged from Google Drive
or Dropbox to Codebook Desktop

o B
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Important Preferences



Customize Labels S )

Database Information W Customize Labels
mm B 8©° bl %y
. Label Mode Masked | Usage Count
Add new custom labels K Favorites
2-Step Code 2-Step Key (TOTP) No 3
. . @ Recents Account Number No 13
Customize behaviors :
. Address Plain Text No 1
{9 History
Birthday Date No 2 i
E bl k Categories
naple mas |ng Cvv/cvC Number Yes 6
, Airlines Card Number Number No 3
Available under File -> Customize ) . Combination Passwiord Yes ?
£ Cloud Services
Credit Limit Number No 5
Labels _ %
[~ ] Credit Cards
Merge Add Delete
% Delivery
LY
ay 24, 2021 9:46:32 AM
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Autolock #2 General Q Sync B2 Secret Agent (€ Updates
. Preferences
Leaves application unlocked for a
designated period of time (default 5
minutes) Automatically lock after | 5 minutes ’-
Automatically locks application when Sort labels by Frequency of use v

timer expires

Display notification when application locks
Allows more convenient access
without repetitious logins D Send Anonymous System and Usage Statistics

Tip: Be careful, when autolock is Save Cancel
enabled

Available under File -> Preferences
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Secret Agent Fle Edit Sync View Help

EEB B RE /28 x| ®©0o@00 | ¢ v Q.

Choose the key sequence to launch K Favorites
& General Q Sync B SecretAgent (¥ Updates

Secret Agent Q@ recents
@ History

Preferences

-u Run Secret Agent at Windows Login

Enable Codebook and Secret Agent to

launch on login (in a locked state) St I —
l Airlines LeftShift + LeftCtrl + \ - P —
q Cloud Services Save Cancel

-_ Credit Cards

M Delivery

LY
B B sentris 2 Edit  Updated At: Monday, May 24, 2021 9:46:32 AM
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Other Features



Change Master \
Password N

File Edit Sync View Help

EEbB B BE /A8 x | ®O0 BB O | &V Q.

* Favorites l American Airlines < ::?:::ca“ Alrlines
Available under File -> "
Recents

Images
Change MaSter Password 4 Current Password: | eeeeeeeesececcee l
'@ History
customer1974
New Password: I ooooooooooooooo l
Categories
. Confirm Password:| eeeeeeececcecee o | ............
‘ / Airlines | !
o
Save Close
Q Cloud Services
—_—
(=} Credit Cards
% Delivery
LY
B B sentries ZEdit  Updated At: Monday, May 24, 2021 9:46:32 AM
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Magnify a Field

To Magnify a field in an entry:

1. Right click on a field. The
Field Options Menu will be
displayed.
2. Click Magnify [field type].
3. The value of the field will be displayed in
a large font.

1- Right
Click

File Edit Sync View Help

mE B BRB /20 x| ®0 @B DO | OV Q,
. T2l s Diner's Club

* Favorites B9E 101k EIE Z, Financial w
@ Recents : Banque Cantonale de G...

L) History Checking A CO thl + C

O - py 24231123
Categories S Debit a

s Hide Account 7
ﬁ Documents —
: @@ Diner's Clul

o Magnify Account  Ctrl+y < 2

=== Family

e - eWallet

‘ Financial =] B B L Payment Due 10th of the month every 3 months

Vel
M

467/6645424231123
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